
G Suite Training
Level I

May 10, 2018 @ 8:30 A.M. – 10 A.M. 

Training Websites: 

gsuite.google.com/learning-center 

edutrainingcenter.withgoogle.com/resources 

support.google.com/a/answer/7039472?hl=en 
These links can be accessed from cooperstowncs.org – Departments – I.T. Department Site 



A few reminders & FAQs: 

• District Chromebooks require you to logon with your @ccsmail.org email address.  You
can gain access to your @cooperstowncs.org email, after you login and by “adding an

account”. 

• K-6 Students do NOT have email access and 7-10 have internal email access only.  Make
sure you are using your @ccsmail.org email account when emailing students, sharing

files, and using Google Classroom.  They do not “mesh” well with each other! 

• Chromebooks can print, but they only have a few printers.  They are labeled by room or area.
“Follow-Me” printing allows you to send a job to any copier and have it print, after you sign

onto the copier. 

• When you go to print, make sure your @ccsmail.org account is selected.  You won’t see our
Cloud Printers / Copiers, if this isn’t selected. 

• Google Classroom is the best tool to use to have students hand in documents.  It keeps
everything streamlined and organized and reduces the amount of “Shared with Me” documents

and emails you get.  It also makes grading and paperless options much more easier! 

• Training is always available through the “Synergyse” Extension.  This is preloaded on
Chromebooks, AD Computers, and when you sign into Chrome, using your @cooperstowncs.org 
email or @ccsmail.org email accounts.  It can also be installed for free at any time, through the 

Chrome Store (or the IT Portal). 
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Account Basics 

Cooperstown Central School District has two Google domains. 

 The cooperstowncs.org account is used only for staff and is the main account to be used for 

communications with other staff members and parents. 

 The ccsmail.org account is used for all students and staff that interact with students and/or use a 

district Chromebook. This account should not be used to contact parents or used as the main account. 

Please note, that this summer we will be switching to one domain for staff, of which will be able to be used on 

Chromebooks. The ccsmail.org domain will still be for students. Staff will only have one account to monitor 

and keep track of, which will be a welcome change for all! 

 

The cooperstowncs.org domain is tied into your network account. This network username is used for the 

district computers, district WiFi, I.T. Portal, PaperCut, TripTracker, and ClassLink. If you need to reset your 

password, simply visit a district computer and login, press CTRL+ALT+DEL and then “Change Password.” You 

cannot reset your password, from within your cooperstowncs.org Google account. 

The ccsmail.org domain is not tied to any other account. To reset this password, please see Emily Gibson, Kris 

Potrikus, Michelle Hitchcock, Karen Lyons, or Elliot Thomas. If students forget their passwords, they can see 

the same staff members for that information. 

 

 

ClassLink is a great tool to help remember usernames and passwords from all of the district and personal 

accounts you may have. ClassLink is offered to all students and staff members and even lets you link your 

district Google account for easy one-click access. It even lets you access district files and Microsoft Office, even 

if you do not have that installed, from one interface. 

To access ClassLink, visit the district webpage, click Elementary or Jr/Sr High, and then ClassLink on the right-

hand side. Help guides are offered as well for first time setup and general assistance. 
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Chromebook Basics 

 Who is issued a district Chromebook? 

 

 Who manages the district Chromebooks? 

 

 The general concept of Chromebooks and why we use them 

 

 1:1 Program 

 

 Logging into a Chromebook 

 

 Locating Apps 

 

 Pinning and Sorting Apps 

 

 Personalizing your Google account 

 

 Accessing G Suite 

 

 Printing 

 

 Signing out / Shutting down 

 

G Suite Basics 

 What is “G Suite”? 

 

 G Suite VS Microsoft Office 

 

 How to access the different G Suite Apps 

 

 Basics on signing out of and signing into Google accounts 
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Gmail 

Since the district is a “Google School,” our email is “Gmail.” You can access the district email system by simply 

going to gmail.com; clicking the “Gmail” shortcut on the Chromebook; using the Gmail app on your phone or 

tablet; or by clicking “Gmail” on the “staff resources” page. 

Gmail will be getting a face-lift this summer, but you can upgrade to the new interface at any time. There is no 

drastic changes, more of appearance and productivity upgrades being made. If you would like to upgrade to 

the new interface, click on the gear icon below your avatar in the upper right hand corner, and select “Try the 

new Cooperstown Central School Mail”: 

 

  

5



Lesson 

Please open Gmail, logging into your cooperstowncs.org account, WITHOUT logging out of your ccsmail.org 

account. 

Once in your cooperstowncs.org account, please compose a new email message to your ccsmail.org account, 

with the subject “G Suite Training”. Please “CC” the message to ethomas@cooperstowncs.org. You can write 

anything in the subject. Send the message. 

 

 

Now, go into your mail settings and create a new email signature that has your name, position, and the 

district. You can add the district address and/or phone number if you wish. 

 

 

Now, lets create a new label (“folder”) and a rule, that will label messages that you have replied to, for easier 

viewing. You may be use to calling your “inbox” or “spam” or “sent” locations folders, but Google calls them 

labels. Labels help you to sort your messages, so that you can review them easier or sort your inbox better. 
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To create a new label, go into Settings > Labels > Labels and then click on “Create new label”. We will call the 

new label REPLIED and will not nest it under a different label. Click Create. 

 

Now that we have a label, we will make a rule so that any emails that you have replied to, will be marked with 

that label. 

Go into Settings > Filters and Blocked Addresses > Create a new filter. 

In the “From” section, type (me) and in the subject section, type (Re:), click “continue.” Check the box that 

says “Apply the label:” and selected “REPLIED.” Check the bottom box that says, “Also apply filter to matching 

conversations.” Once you are done, click “Create filter.” 
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Lastly, go to your labels on the left hand side of the screen, find the label “REPLIED” and change the label color 

to dark blue (or a color of your choice). To get into label settings, click the three dots that appear next to the 

label when you hover over it. 

 

Now, your inbox should have “REPLIED” next to messages that have been replied to you by yourself. 

 

Filters are very powerful and offer many different rules. Some filters that I have personally created are 

automatically marking attendance emails as read, marking emails from PowerSchool with a special label and 

removing them from my inbox and into the “folder” automatically, and so on… 
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Calendar 

Google Calendar integrates very well with Gmail. Opening calendar can be done a few different ways. You can 

navigate to calendar.google.com, click the “Calendar” shortcut in the “Google Apps” drawer, or by clicking the 

shortcut on the sidebar in Gmail. 

When you open Google Calendar, you should see a few different calendars, depending upon what was shared 

with you, what building you work in, and what department you are in: 

1. District Activities (on website) 

2. Elementary School Activities (on website) 

3. Elementary School Field Trips (private, managed by Lara & Jackie) 

4. Elementary “Conference Rooms” (private, managed by Jackie) 

5. Jr / Sr High School Activities (on website) 

6. Jr / Sr High School Assemblies (private, managed by Alena & Maria) 

7. Jr / Sr High School Field Trips (private, managed by Alena & Maria) 

 

The ones in bold are the calendars that are on our district website. If you are missing any calendars, adding 

them is easy!  Visit goo.gl/e1vB3U and click the URL of the calendar you would like to add. Please note, that 

you will need to login to the I.T. Portal with your network username (NOT your email). 

 

If there is a calendar that you do not wish to see, simply 

“uncheck” the calendar on the left hand side. 

 

When a calendar is visible, the color of the calendar and a white 

checkmark will appear to the left of the calendar. 

When a calendar is hidden, the box will be white. 

 

To change the color of 

the calendar, hover over 

the calendar and click 

the triple dots. Then you 

can pick a different color 

to help color code them 

to your liking. 
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If there is a calendar present that you do not wish to see again, you can unsubscribe from the calendar by 

clicking the “X” button when you hover over it. 

 

This will not delete the calendar or send an email to anyone that you have unsubscribed from a particular 

calendar. 
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Lesson 

Please open Gmail, logging into your ccsmail.org account, WITHOUT logging out of your cooperstowncs.org 

account. 

Once in your ccsmail.org account, open the message from yourself that has the subject “G Suite Training.” Add 

this email to your calendar as an event. 

 

Change the date and time to: 

MAY 11, 2018 8:00am  to  10:00am May 11, 2018 

Add ethomas@cooperstowncs.org and kpotrikus@cooperstowncs.org as guests. Allow us to modify the event. 

 

You will notice that Google automatically puts the email subject as the event name and the message body in 

the description / memo section. 
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Opps! The training course has been changed to 8:30 a.m. start time. Drag the calendar even down to 8:30 

a.m., by clicking and holding the event and dragging it down slightly. 

 

However, the event also ends at 10:00 a.m. Change the end time by dragging the bottom of the event up, so 

that it changes to 10:00 a.m., without moving the actual event “up.” 

 

The event should now be 8:30 a.m. to 10:00 a.m. on May 11.  
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Drive 

Google Drive is a “cloud based storage center” that allows an “unlimited” amount of storage space. Of course, 

using your Cooperstown Central School District Google account must comply with the District’s “acceptable 

use policy” and “confidentiality policies.” 

Google Drive can be opened a few different ways. You can navigate to drive.google.com; click the “Drive” 

shortcut in the “Google Apps” drawer; or by clicking the shortcut on the Chromebook taskbar. 

On the left hand side, you will see a few different options: 

 

“NEW” allows you to create a new folder, document, or upload a file / folder 

to your Google Drive account. 

“My Drive” is your personal drive of files that you either own or have moved 

to your personal drive section. 

 

“Shared with me” are documents that have been shared with you, by 

someone else. 

“Recent” are documents or folders that you have recently edited or 

uploaded. 

“Starred” are documents or folders that you have starred (“favorited”) for 

easier access. 

“Trash” is the recycle bin where files and folders go, when you delete them. 

They stay in here for a while until they are “permanently” deleted. 

 

At the top, you’ll see your recent files listed first under “Quick Access” and then your files listed below in the 

sort order of your choosing. 
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When you click on a file or folder, the information about the data is located on the right hand side: 

Under the “DETAILS” tab, you will see who the file belongs to and who has access by the avatars at the top. 

The file type is listed below, as well as other information. 

Clicking the “ACTIVITY” tab, allows you to see recent edits to the file, as well as sharing information, and when 

such changes happened. 
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When you are browsing files, you can easily see what files / folders are shared and which ones are not by the 

avatar logo. 

 

To change the sharing options, click the “Share” button on the top. 

 

Here, you will be able to share a link with others, add specific users to the sharing list, or restrict who can view 

/ comment / edit the document or folder. 
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Lesson 

Please open Drive, logging into your ccsmail.org account, WITHOUT logging out of your cooperstowncs.org 

account. 

Create a new folder called “G Suite Training.” 

 

Share the new folder with ethomas@cooperstowncs.org and kpotrikus@cooperstowncs.org and uncheck 

“Notify people” to turn off the email notification that you have shared a folder with us. Make sure to give us 

“editing” rights. 

 

Change the folder color to “red” and “star” it. 
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Rename the folder to “G Suite Training – May 2018.” 
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Docs 

Google Docs is similar to Microsoft Word and is Google’s word processing program. The easiest way to create 

a new document is by selecting NEW > Google Docs in Drive or by clicking the “Google Docs” shortcut in the 

system tray of a district Chromebook. 

A new Google Doc will look similar to this: 

 

The ribbon at the top hosts all of the editing and formatting tools, similar to the Office Ribbon in Word. 

 

There is no save button as Google Docs automatically saves as you go and retains editing history and 

undo/redo at all times. The most important step in making sure that you can locate the file easily next time 

and that Google does save the document periodically, is to first name the document! 

 

When you are working on a document and would like to add pictures and research content easily, you can use 

the “Explore” feature. You can access “Explore” by clicking on the button located in the bottom right hand 

corner or by going to Tools > Explore. 

      

All pictures that show up in the explore tool, have been filtered by the explicit search tool and by creative 

commons. All pictures that show up, can be used without references (if such research allows) and can be 

edited to your liking. The same results will not appear in Google Image search, as the “creative commons only” 

tool is disabled by default. 

 

 

 

 

18



Lesson 

Please open a Google Doc, logging into your ccsmail.org account, WITHOUT logging out of your 

cooperstowncs.org account. 

Call the document “G Suite Training Notes.” Star the document. 

Create a bulleted list with the following: 

 Google Docs 

 Google Sheets 

 Google Slides 

Bold the word “Docs.” 

 

Add a few lines after the last item and click the Explore tool. Find a picture of the Google logo. Insert the 

picture and then change the size, so it is small but still visible. Center the image. 

 

Change the page setup so that it is “Landscape” 
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Add a horizontal line, below the image, and type a sentence or two – anything you would like. Change the font 

to 16-point and highlight it in yellow. Hyperlink one or two words to cooperstowncs.org. 

     

 

 

Move the document to your “G Suite Training – May 2018” folder, if it is not already there. 
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Sheets 

Google Sheets is similar to Microsoft Excel and is Google’s spreadsheet program. The easiest way to create a 

new sheet is by selecting NEW > Google Sheets in Drive or by clicking the “Google Sheets” shortcut in the apps 

menu of a district Chromebook. 

A new Google Sheet will look similar to this: 

 

The ribbon at the top hosts all of the editing and formatting tools, similar to the Office Ribbon in Excel. 

 

There is no save button as Google Sheets automatically saves as you go and retains editing history and 

undo/redo at all times. The most important step in making sure that you can locate the file easily next time 

and that Google does save the document periodically, is to first name the document! 
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Lesson 

Please open a Google Sheet, logging into your ccsmail.org account, WITHOUT logging out of your 

cooperstowncs.org account. 

Call the document “G Suite Training Grades.” 

Enter the following data as headers: 

First Name, Last Name, Assignment, Grade 

Change the font size of the headers to “12”, center them, bold them, and underline them. 

 

Add the following data to the sheet: 

Lawrence Page, Google Doc, 85 

Eric Schmidt, Google Doc, 79 

Alan Mulally, Google Sheet, 100 

Ruth Porat, Google Slides, 62 

 

Add a formula to add up how many students there are and for the average grade of all assignments. 

 

HINT TIME: To make a formula calcuate, you must always type = in the beginning of a formula. To count how 

many cells are populated with data, click in cell A6 and type =COUNTA(A2:A5). The formula “counta” will 

count how many cells have data in them and will provide the number. Formulas will always update, which is 

nice versus manually counting and typing data in. To find the average of a group of cells, click in cell D6 and 

type =average(D2:D5). Both cells should read 4 and 81.5, respectively. 
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Of course, Tanner Muflin submitted his work late! Add the following data to the sheet in row 4, without 

deleting any data: 

Tanner Muflin, Google Sheet, 90 

HINT TIME: Right click row 3 and select “Insert 1 Below.” 

      

Both formulas should have changed to 5 and 83.2, respectively, automatically. 

Now, go to Google Drive by clicking the “Google Sheets” logo.  Then, click on the sandwich menu in the upper 

left corner and click “Drive.” 

      

Go the “Recent” section in Google Drive and find the “G Suite Training Grades” spreadsheet. 
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Move the spreadsheet to your “G Suite Training – May 2018” folder. 

      

Navigate to the “G Suite Training – May 2018” folder and make a copy of “G Suite Training Grades” document 

and rename it “G Suite Training Grades 2.” 
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Slides 

Google Slides is similar to Microsoft PowerPoint and is Google’s slideshow program. The easiest way to create 

a new presentation is by selecting NEW > Google Slides in Drive or by clicking the “Google Slides” shortcut in 

the apps menu of a district Chromebook. 

A new Google Slide will look similar to this: 

 

The ribbon at the top hosts all of the editing and formatting tools, similar to the Office Ribbon in PowerPoint. 

 

There is no save button as Google Slides automatically saves as you go and retains editing history and 

undo/redo at all times. The most important step in making sure that you can locate the file easily next time 

and that Google does save the document periodically, is to first name the document! 

 

Google Slides has many different themes you can choose from. If you close out the themes picker, you can get 

back to it by going to Slide > Change Theme. 
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Lesson 

Please open a Google Slide, logging into your ccsmail.org account, WITHOUT logging out of your 

cooperstowncs.org account. 

Call the document “G Suite Training Lesson.” 

Apply the theme “Marina” and add two additional slides (three altogether). 

 

On the first slide, title it “G Suite Training” and as the sub-title type “May 2018.” 
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On the second slide, title it “Google Drive,” delete the lower text box, and insert a picture with the “Explore” 

tool of a Google Drive logo. 

 

On the third slide, title it “Gmail” and center the title. Type a few random notes in the second textbox and 

change the font color to orange. 

Opps! We need the title to not be centered. Clear the formatting of the title using the “Clear Formatting” tool. 
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Now, add the “Dissolve” animation to all slides with a “2.0 second” transition time. 

      

Move the spreadsheet to your “G Suite Training – May 2018” folder, by using the “folder” icon next to the 

document name. 
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Your “G Suite Training – May 2018” folder should look like the below image: 
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Classroom Basics 

Google Classroom is a very powerful resource for teachers and students. You can access Google Classroom by 

clicking on the “Classroom” shortcut in the system tray of a district Chromebook or in the apps drawer on your 

Google account. 

The first time you open Google Classroom, make sure you select “Teacher.” This way you will be able to create 

classes, join classes, and have elevated privileges. If you accidentally select “Student,” please let the I.T. 

department know. 

Google Classroom is an easy way to organize classes, create calendars specific periods / sections, and assigning 

and collecting classwork all in one system. Google Classroom allows the teacher to track who submitted what 

work and can even provide grades, if they so wish to use that tool. 

 

For more information on Google Classroom, see the cheat sheet attached to this guide! 

 

Read&Write Basics 

“Read&Write … makes the web, documents and files more accessible – any time, any place, and on any 

platform or device. It’s great for people with dyslexia and other learning difficulties, or anyone whose first 

language isn’t English.  From reading on-screen text aloud to researching and checking written work, 

Read&Write makes lots of everyday tasks easier. It’s a big confidence booster for anyone who needs a little 

extra help with their reading and writing, at school or in the workplace.” – texthelp.com 

“Snapverter is an easy to use add-on for Read&Write for Google Chrome™ that transforms classroom papers 

and files into readable PDF documents for easy sharing and reading aloud via Google Drive. Pick any 

inaccessible file to convert – or just grab your smartphone and snap a photo of paper documents. Then share 

converted files with students and other teachers on any device – PCs, Macs, Chromebooks or tablets.” 

– texthelp.com 

  

Read&Write Software is managed through the CSE Department and maintained by the I.T. Department.  For 

any technical questions or training, please contact the CSE Office. 

  

Signing into a Chromebook 

Logon with your @ccsmail.org account.  After your account synchronizes, you should see a puzzle piece 

(similar to the logo above) in the upper right-hand corner. 

Click the puzzle piece to open the Read&Write toolbar. If you are using Read&Write for the first time, you need 

to click AGREE on the permissions and terms pop-up, on first run. 
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Cheat Sheets 

Of course, what would be a training guide, without some Cheat Sheets?! 

 

Thank you very much for taking the time today to go over the G Suite package with us! We 

appreciate your time and hope that you have learned a few things! Looking into the future, we 

hope to bring more, slightly longer, trainer courses to Cooperstown Central School District! 

 

 

If you have any questions, please feel free to let us know! 

 

Maureen Shuermann; Licensed Teaching Assistance 
Elementary Library-Media Center 

Kris Potrikus; Licensed Teaching Assistance 
Elementary Lab 338 

Elliot Thomas; Computer Services Specialist 
Jr/Sr High School Room 128 (office) & Elementary Lab 338 
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y texthelp read&write

Read&Write for Google Chrome™
Quick Reference Guide 12.17

f m El ► 11 ■ s i >» ：= n i* □
-|j|

Docs, Slides and Web
Tool Symbol Where it works How it works

Text to Speech

► Google Docs 

Google Slides

Web

Reads text aloud with dual color highlighting and 

natural-sounding voices.

Highlight or place your cursor in front of some text, and click 

the Play button.

Hover Speech Web
Reads text on websites in Chrome without highlighting, 

simply hover over the text you’d like to read.

Talking

Dictionary

i10 Google Docs 

Google Slides 

Web

Provides definitions to improve comprehension and 

writing. Definitions can even be read aloud.

Highlight a word and click the icon. Click the Play button 

next to each definition to have it read aloud.

Picture

Dictionary

*
Google Docs 

Google Slides 

Web

Displays images from Widgit® Symbols to help support 

fluency and understanding.

Prediction

Google Docs 

Google Slides 

Web

Provides word suggestions as you type. Develops writing 

skills and helps construct error-free sentences more easily.

Hover over word suggestions to hear aloud. Click on a word 

or click Ctrl + the number next to the word you’d like to 

insert.

Web Search

& Google Docs 

Google Slides 

Web

Helps with research by doing a Google search for relevant 

information on a topic.

Highlight a word or phrase and click the icon, and a Google 

search will open in a new tab.

Translator

'A Google Docs 

Google Slides 

Web

Allows single words to be translated into Spanish, French or 

Portuguese and spoken in that language.

Translation language can be selected in Settings menu.

Highlights & 

Erase

Highlights £

Google Docs 

Google Slides 

Web

Allows users to highlight and color code sections of text on 

a page, to facilitate summarizing, categorizing and higher 

order skills.

Erase highlights from a page when you are done with them, 

by selecting highlights and clicking the icon.
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OF texthelp •Q read&write

Collect

Highlights

<f>^
x?

Google Docs

Web

Vocabulary List 

Builder

■ Hi
■ «H

■ Hi

Google Docs

Web

Audio Maker

Google Docs 

Google Slides

Web

Screenshot

Reader

Google Docs 

Google Slides

Web

Voice Notes
Google Docs

Talk&Type o Google Docs

Web

Simplify
—

Web

Screen Masking e Google Docs 

Google Slides

Web

Practice

Reading Aloud A Google Docs 

Google Slides

Web

Dropdown

Menu D Google Docs 

Google Slides

Web

Collects your highlights into a new Google Doc.

Click on icon and select which colors to collect, as well as 

how to sort them.

Builds vocabulary lists in a Google Doc, including selected 

words, dictionary definitions, images from Widgit Symbols, 

and an editable notes column.

Use colored Highlights to select words, then click icon to 

create vocabulary list in new Google Doc.

Converts selected text into an audio file, e.g. MP3, which will 

be automatically downloaded and can then be saved or 

shared in Google Drive.

Converts inaccessible text to accessible text through OCR.

Click the icon and then drag your mouse to draw a 

rectangle around any inaccessible text, to OCR it on 

demand.

Records a short audio file (one minute or less) of your voice, 

and inserts it into a Google Doc as a comment.

Highlight text where you'd like to place your comment, then 

click the icon and use the microphone button to record. Use 

additional options to stop recording, replay or insert.

Turns the spoken word into text by dictating into a 

microphone.

Removes clutter from web pages and places the simplified 

text into a new tab.

Use the + and - icons to change the amount of text 

displayed. Contrast controls are also available.

Tints your screen and provides a spotlight that follows your 

mouse pointer, to help improve focus.

Allows students to practice and record themselves reading 

selected text, use support tools, listen to their recording, 

and send to their teacher for feedback.

Access options to customize speech, prediction, language 

and toolbar. Also includes links to get support, leave 

feedback, and more.
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qp texthelp
PDFs

read&write

Tool Symbol

Text to Speech

How It works

Reads text aloud with dual color highlighting and natural-sounding voices. 

To use, select some text and click the Play button.

Click to Speak

Reads any text aloud by simply clicking on it.

When the feature is on, you'll see a purple line under the button. Click again to 

turn off.

Talking

Dictionary

Provides definitions to improve comprehension and writing. Definitions can 

even be read aloud.

Highlight a word and click the icon. Click the Play button next to each 

definition to have it read aloud.

Picture

Dictionary

Displays images from Widgit® Symbols to help support fluency and 

understanding.

Converts inaccessible text to accessible text through OCR.

Screenshot

Reader
Click the icon and then drag your mouse to draw a rectangle around any 

inaccessible text, to OCR it on demand.

Translator

Allows single words to be translated into Spanish, French or Portuguese and 

spoken in that language.

Translation language can be selected in Settings menu.

Highlights

Erase

Highlights

&

Allows users to highlight and color code sections of text on a page, to facilitate 

summarizing, categorizing and higher order skills.

Highlight some text, and then click the Highlighter icon to choose from four 

colors. Select some highlights and click the Erase icon to remove.

Collect

Highlights

Collects your highlights into a new Google Doc.

Click the Highlighter icon and then click Collect. Select which colors to collect, 

as well as how to sort them.

Builds vocabulary lists in a Google Doc, including selected words, dictionary 

■ definitions, images from Widgit Symbols, and an editable notes column.
Vocabulary List

Builder B Use colored Highlights to select words, then click icon to create vocabulary list

in new Google Doc.
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read&writeqp texthelp
Allows you to type text directly on your PDF. Great for note-taking and

Typewriter

Annotation T
completing worksheets.

Click the icon and then click where you'd like to place your annotation. Use the 

additional options to change font size or color, save, delete, reposition or play 

back your annotation. Talk&Type and Prediction can also be used here.

Pushpin

Annotation

*

Allows you to insert notes, instructions or helpful hints on your PDF. Leaves a 

red pushpin icon wherever the annotation was made.

Click the icon and then click where you'd like to place your annotation. Use the 

additional options to change font size or color, save, delete, reposition or play 

back your annotation. Talk&Type and Prediction can also be used here.

Block Read

Aloud

s®
Allows teachers to block sections of text from being read with Text to Speech 

by their students. To use, select some text, click the Highlighter icon and click 

Block Read Aloud.

Requires Google Classroom integration.

Allows you to comment directly in your PDF. Great for collaboration and 

discussion with others.

Comments <D Select some text where you'd like to make a comment, and click the Comment 

icon. Prediction, Talk&Type and Voice Notes are available here.

You can also insert an image or link INI in your Comment.

Use the Play button to hear your comment read aloud.

Talk&Type

Prediction

O

Ê

Allows you to dictate into Comments and Typewriter/Pushpin Annotations 

using a microphone.

Provides word suggestions as you type in Comments or Typewriter/Pushpin 
Annotations.

Hover over word suggestions to hear aloud. Click on a word or click Ctrl + the 

number next to the word you'd like to insert.

Voice Notes

Records a short audio file (one minute or less) of your voice, and inserts it into 

a comment.

►
Select some text in your PDF and click the Comment icon, then click the Voice 

Notes icon. Use the Microphone button to start recording, and then you can 

play back, record again, or insert into the PDF.

Save to Google 

Drive

Allows you to save web-based or local PDFs to your Google Drive. Click the 

icon and then choose where in your Drive you'd like to save the PDF.

Share to 

Classroom

Allows teachers to share a PDF through Google Classroom. Once shared or 

posted to the class, students can open the PDF from Classroom, then use the

PDF Reader to read, respond, and hand in Q

Requires Google Classroom integration.
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Dropdown

Menu

Access options to customize speech, language and more. Also includes links to 

get support, leave feedback, and more.

ePUBs

Tool Symbol

Text to Speech

Click and Speak

Study Skills 

Enable/

Disable

Bookmark

Talking

Dictionary ««

Web Search

Translator 3$

Reads text aloud with dual color highlighting and natural-sounding voices. 

Highlight some text, and click the Play button.

Reads any text aloud by simply clicking on it.

Click the icon and it will turn red, indicating the feature is on.

Choose from Dictionary, Picture Dictionary, Web 

Search, Translator, and Highlights on the pop-up

menu pictured here.

Click the icon to enable or disable the menu 

from appearing when text is selected.

&\y：

Picture

Dictionary

Marks a page in your ePub so you can refer to it later. A list of your bookmarks 

is included in the Table of Contents sidebar menu.

Click the icon to insert a bookmark, and add a note. Click icon again to remove 

bookmark.

Provides definitions to improve comprehension. Definitions can even be read 

aloud.

Highlight a word and click the icon. Click the Play button next to each 

definition to have it read aloud.

Helps with research by doing a Google search for relevant information on a 

topic.

Highlight a word or phrase and click the icon, and a Google search will open in 

a new tab.

Allows single words to be translated into Spanish, French or Portuguese and 

spoken in that language.

Translation language can be selected in Settings menu.

0 I Displays images from Widgit® Symbols to help support fluency and 

1 understanding.
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Push Pin 

Annotation

Allows you to insert a note in your PDF, such as a comment or instructions to 

students.

Click the icon and your cursor will become a pushpin. Click to place the 

annotation in your PDF.

Highlights & 

Erase highlights

Allows users to highlight and color code sections of text on a page, to facilitate 

summarizing, categorizing and higher order skills.

Erase highlights from a page when you are done with them, by selecting 

highlights and clicking the icon.

Collect

Highlights

c*
Collects your highlights into a new Google Doc.

Click on icon and select which colors to collect, as well as how to sort them.

Vocabulary List 

Builder

u^m
■ M
■ Hi

Builds vocabulary lists in a Google Doc, including selected words, dictionary 

definitions, images from Widgit Symbols, and an editable notes column.

Use colored Highlights to select words, then click icon to create vocabulary list 

in new Google Doc.

Settings |0 Customize speech options, language settings, and preferences for how to 

collect highlights and create vocabulary lists.

Display Table of 

Contents

■ ■■
■ ■

■ Hi

Display your ePub's table of contents as well as all bookmarks you have made 

throughout the ePub.

Font Options
Av Customize the font type, size, alignment and color of the text in your ePub 

viewer.

Helpful videos: http://bit.ly/RWGoogleVideos 

Technical Support: http://support.texthelp.com 

Training Portal: https://training.texthelp.com
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Work	faster	and	collaborate	better	with	powerful	email	features.
Create	and	send	email,	reply	to	threaded	email	conversations,	and	organize	your	inbox.

1	 Click	 Compose 	to	create	a	new	email	message.
	2	 Click	a	message	in	your	inbox	to	read	it	and	send	a
reply.

3	 Organize	your	inbox.

	Learning	Center
gsuite.google.com/learning-center

gmail.google.com

	 	Gmail	Cheat	Sheet

1©2018	Google	LLC,	1600	Amphitheatre	Parkway,	Mountain	View,	CA	94043,	USA
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Keep	all	your	work	in	one	secure	place	with	online	file	storage.
After	you	store	your	files	in	Google	Drive,	you	can	share	them	with	others	and	access	them	on	any	computer,
smartphone,	or	tablet.	When	you	change	or	delete	a	file	stored	in	one	of	these	locations,	Drive	makes	the	same

change	everywhere	else	so	you	don’t	have	to.

1	 Click	 NEW 	to...

	Upload	any	file	(such	as	Outlook	files,	PDFs,	and	videos)	or	folder	from	your	computer.

	Create	new	documents	right	in	your	browser.

Editor Description Example	uses

docs	Google	Docs Text	documents Proposals,	reports,	shared	meeting	notes

sheets	Google	Sheets Spreadsheets Project	plans,	budget	sheets

slides	Google	Slides Presentations Pitch	decks,	training	modules,	team	presentations

forms	Google	Forms Surveys Customer	satisfaction	surveys,	group	polls

drawings	Google	Drawings Shapes,	charts,	and	diagrams Flowcharts,	organizational	charts,	website	wireframes,	mind	maps

sites	Google	Sites Websites Team	sites,	project	sites,	resume	sites

2	 Work	with	files	stored	in	Drive.

	Learning	Center
gsuite.google.com/learning-center

drive.google.com

	 	Drive	Cheat	Sheet

1©2018	Google	LLC,	1600	Amphitheatre	Parkway,	Mountain	View,	CA	94043,	USA
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3	 Share	your	files	and	folders	by	clicking	Share		and	then	choose	what	collaborators	can	do.	They'll	get	an
email	notification,	too.

	 Delete	files	and	folders Add	and	remove	files	and	folders Share	or	unshare	files	and	folders Edit	Docs	files Comment	or	suggest	edits	in	files

Can	edit     
Can
comment

    

Can	view     

4	 Add	shared	files	to	My	Drive.

Note:	When	you	move	a	shared	file	to	My	Drive,	it	only	moves	the	file	in	your	view,	not	in	anyone	else’s.

5	 Access	your	files	from	any	device.

	Learning	Center
gsuite.google.com/learning-center

drive.google.com

	 	Drive	Cheat	Sheet

2©2018	Google	LLC,	1600	Amphitheatre	Parkway,	Mountain	View,	CA	94043,	USA
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Browser	or	device Requirements How	to	access

	Web	browser	(any
device)

Install	any	web	browser. Go	to	drive.google.com.

	Computer Install	Drive	File	Stream	from	the	Drive	Help	Center. Click	Drive	File	Stream		and	then	Open	Google

Drive	.

	Mobile	devices Install	the	Drive	app	from	the	Play	Store	(Android)	or	App	Store
(iOS).

Open	the	Drive	app	on	your	device.

	Learning	Center
gsuite.google.com/learning-center

drive.google.com

	 	Drive	Cheat	Sheet

3©2018	Google	LLC,	1600	Amphitheatre	Parkway,	Mountain	View,	CA	94043,	USA
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Create	and	simultaneously	edit	text	documents	with	your	team,	right	in	your	browser.
Write	reports,	create	joint	project	proposals,	keep	track	of	meeting	notes,	and	more.	All	changes	are	saved

automatically.

1	 Edit	and	add	styles	to	your	text.

2	 Work	with	different	versions	and	copies	of	your
document.

Make	a	copy—Create	a	duplicate	of	your	document.
See	revision	history—See	all	the	changes	you	and	others	have	made	to	the
document	or	revert	to	earlier	versions.
Download	as—Download	your	document	in	other	formats,	such	as	Word	or
PDF.
Publish	to	the	web—Publish	a	copy	of	your	document	as	a	webpage,	or
embed	your	document	in	a	website.

	3	 Enhance	your	document	by	adding	features.

Image—Insert	an	image	from	your	computer,	the	web,	Drive,	and	more.
Link—Add	a	link	to	a	webpage	or	a	header	or	bookmark	in	your	document.
Drawing—Create	pictures,	flowcharts,	diagrams,	and	more.
Table—Select	the	number	of	columns	and	rows	to	create	a	table.
Bookmark—Add	shortcuts	to	specific	places	within	your	document.
Table	of	contents—Create	an	autogenerated	table	of	contents	that	links	to
each	heading	(where	you’ve	applied	heading	styles).

4	 Click	 Share 	to	share	your	document	and	then	choose	what	collaborators	can	do.	They’ll	also	receive	an
email	notification.

	 Share	or	unshare Edit	content	directly Suggest	edits Add	comments

Can	edit    
Can	comment    
Can	view    

5	 Collaborate	with	your	team	in	real	time.

	Learning	Center
gsuite.google.com/learning-center

docs.google.com

	 	Docs	Cheat	Sheet

1©2018	Google	LLC,	1600	Amphitheatre	Parkway,	Mountain	View,	CA	94043,	USA
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	Learning	Center
gsuite.google.com/learning-center

docs.google.com

	 	Docs	Cheat	Sheet

2©2018	Google	LLC,	1600	Amphitheatre	Parkway,	Mountain	View,	CA	94043,	USA
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Create	and	simultaneously	edit	spreadsheets	with	your	team,	right	in	your	browser.
Analyze	data	with	charts	and	filters,	handle	task	lists,	create	project	plans,	and	much	more.	All	changes	are

saved	automatically.

1	 Customize	your	spreadsheet	and	data.

Note:	To	improve	compatibility	with	Excel	keyboard	shortcuts,	you	can	override	browser	shortcuts.

2	 Work	with	rows,	columns,	and	cells.

	Learning	Center
gsuite.google.com/learning-center

sheets.google.com

	 	Sheets	Cheat	Sheet

1©2018	Google	LLC,	1600	Amphitheatre	Parkway,	Mountain	View,	CA	94043,	USA
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3	 Click	 Share 	to	share	your	spreadsheet	and	then	choose	what	collaborators	can	do.	They'll	also	receive	an
email	notification.

	 Share	or	unshare Edit	content	directly Add	comments

Can	edit   
Can	comment   
Can	view   

4	 Collaborate	with	your	team	in	real	time. 	5	 Create	different	versions	and	copies	of	your
spreadsheet.

Make	a	copy—Create	a	duplicate	of	your	spreadsheet.	This	is	a	great	way	to
create	templates.
See	revision	history—See	all	the	changes	you	and	others	have	made	to	the
spreadsheet	or	revert	to	earlier	versions.
Download	as—Download	your	spreadsheet	in	other	formats,	such	as	Excel	or
PDF.
Publish	to	the	web—Publish	a	copy	of	your	spreadsheet	as	a	webpage	or
embed	your	spreadsheet	in	a	website.
Email	as	attachment—Email	a	copy	of	your	spreadsheet.	

Add	rows,	columns,	and	cells—Select	a	cell	or	block	of	cells.	Then,	on	the	menu	bar,	click	Insert	and	choose	where	to	add	the	row,	column,	or	cells.

Delete	or	hide	rows	and	columns—Right-click	the	row	number	or	column	letter	and	select	Delete	or	Hide.

Delete	a	cell	or	a	block	of	cells—Select	the	cells	you	want	to	delete.	Click	Edit	>	Delete	cells	and	shift	up,	or	Edit	>	Delete	cells	and	shift	left.

Move	rows	and	columns—Click	the	row	number	or	column	letter	to	select	it.	Then,	drag	it	to	a	new	location.

Freeze	header	rows	and	columns—Keep	some	data	in	the	same	place	as	you	scroll	through	the	rest	of	your	spreadsheet.	On	the	menu	bar,	click	View	>
Freeze	and	choose	an	option.

	Learning	Center
gsuite.google.com/learning-center

sheets.google.com

	 	Sheets	Cheat	Sheet
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6	 Work	with	functions

Your	most	important	Excel	functions	exist	in	Sheets,	too.	Here’s	a	few	of	the	things	you	can	do.

AVERAGE Statistical			Returns	the	numerical	average	value	in	a	dataset,	ignoring	text.

AVERAGEIFS Statistical		Returns	the	average	of	a	range	that	depends	upon	multiple	criteria.

CHOOSE Lookup		Returns	an	element	from	a	list	of	choices	based	on	index.

COUNT Statistical		Returns	the	count	of	the	number	of	numeric	values	in	a	dataset.

COUNTIF Statistical		Returns	a	conditional	count	across	a	range.

DATE Date		Converts	a	provided	year,	month,	and	day	into	a	date.

FIND Text		Returns	the	position	at	which	a	string	is	first	found	within	text.

GETPIVOTDATA Text		Extracts	an	aggregated	value	from	a	pivot	table	that	corresponds	to	the	specified	row	and	column	headings.

IF Logical		Returns	one	value	if	a	logical	expression	is	true	and	another	if	it	is	false.

INDEX Lookup		Returns	the	content	of	a	cell,	specified	by	row	and	column	offset.

INT Math		Rounds	a	number	down	to	the	nearest	integer	that’s	less	than	or	equal	to	it.

LOOKUP Lookup		Looks	through	a	row	or	column	for	a	key	and	returns	the	value	of	the	cell	in	a	result	range	located	in	the	same	position	as
the	search	row	or	column.

MATCH Lookup		Returns	the	relative	position	of	an	item	in	a	range	that	matches	a	specified	value.

MAX Statistical		Returns	the	maximum	value	in	a	numeric	dataset.

MIN Statistical		Returns	the	minimum	value	in	a	numeric	dataset.

NOW Date		Returns	the	current	date	and	time	as	a	date	value.

ROUND Math		Rounds	a	number	to	a	certain	number	of	decimal	places	according	to	standard	rules.

SUM Math		Returns	the	sum	of	a	series	of	numbers	and/or	cells.

SUMIF Math		Returns	a	conditional	sum	across	a	range.

TODAY Date		Returns	the	current	date	as	a	date	value.

VLOOKUP Lookup		Searches	down	the	first	column	of	a	range	for	a	key	and	returns	the	value	of	a	specified	cell	in	the	row	found.

	Learning	Center
gsuite.google.com/learning-center

sheets.google.com

	 	Sheets	Cheat	Sheet
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Create	and	simultaneously	edit	presentations	with	your	team,	right	in	your	browser.
Collaborate	on	professional	pitch	decks,	project	presentations,	training	modules,	and	much	more.	All	changes

are	saved	automatically.

1	 Add	and	edit	content	in	your	slides.

2	 Add	and	organize	slides. 	3	 Work	with	different	copies	and	versions	of	your
presentation.

Make	a	copy—Create	a	duplicate	of	your	presentation.	This	is	a	great	way	to
create	templates.
Import	slides—Add	slides	from	another	presentation	to	your	current	slide
deck.
Version	history—See	all	the	changes	you	and	others	have	made	to	the
presentation,	or	revert	to	earlier	versions.
Download	as—Download	your	presentation	in	other	formats	such	as
PowerPoint®	or	PDF.
Publish	to	the	web—Publish	a	copy	of	your	presentation	as	a	webpage,	or
embed	your	presentation	in	a	website.
Email	as	attachment—Email	a	copy	of	your	presentation.

4	 Click	 Share 	to	share	your	presentation,	then	choose	what	collaborators	can	do.	They’ll	also	receive	an
email	notification.

	 Share	or	unshare Edit	content	directly Add	comments

Can	edit   

New	slide—Click	New	slide		in	the	toolbar.	Click	the	Down	arrow	

	to	choose	a	layout	for	the	new	slide.

Move	slide—Drag	the	slide	to	a	different	position	in	the	presentation.
To	move	several	slides	at	once,	Ctrl+click	multiple	slides	before
dragging	them.

Duplicate	slide—Right-click	the	slide	in	the	sidebar	and	select	Duplicate
slide.

Delete	slide—Right-click	the	slide	and	select	Delete	slide.

	Learning	Center
gsuite.google.com/learning-center

slides.google.com

	 	Slides	Cheat	Sheet
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Can	comment   
Can	view   

	 Share	or	unshare Edit	content	directly Add	comments

5	 Collaborate	with	your	team	in	real	time.

	Learning	Center
gsuite.google.com/learning-center

slides.google.com

	 	Slides	Cheat	Sheet
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Google Classroom Cheat Sheet 
Get Started → Create a Class 

● From your web browser, navigate to classroom.google.com & sign up
● Name your class & section
● Classroom automatically creates folders to organize you!

Home - Manage / Access Classes

● Toggle between classes
● Access “Home” screen to :

● (A) Rename or Delete Classes
● (B) View / Access a class Google Drive Folder

This work from TeachingForward.net by Jennifer Judkins licensed under a  
Creative Commons AttributionNonCommercial 4.0 International License  49
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● (C) Settings allows you to turn email notifications on/off

Class Page (Stream) - Discuss / Assign 

● (A) Change Theme by choosing from different available background images
● (B) Announcement - start a class discussion or post a general message to a class

Stream
● (C) Assignment

○ Add assignment name & description
○ Add due date (assignments can be turned in beyond due date but teacher

will see late notification) 
○ Select all Classes you want to assign this item to
○ Add resources: web links, YouTube videos or files from Google Drive
○ Select sharing options for files:

➢ Each student will get a copy (Individual copy added to Google Drive folder for
class which they can edit), View Only, or Student can Edit (allows all students to edit your 
copy of the file) 

● (D) Upcoming Assignments notifications.  Click assignment name to access
Assignment Page **See #6 for details about the Assignment Page pg 4

This work from TeachingForward.net by Jennifer Judkins licensed under a  
Creative Commons AttributionNonCommercial 4.0 International License  50
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● (E) Class Code – Share this code with students so that they can join your class

Students Page - Manage Students

● (A) Invite students to class by email using existing Google contacts lists, Remove
selected students or Email selected students

● (B) Select students or class  to email or remove from class

About Page - Share Class Information & Resources

● (A) Class Information such
as meeting room, teacher
email & associated Google
Drive Folder (auto-created
by Classroom when you add
the class)

● (B) Class Resources - add
resources students will need
access to all year, such as
class website link or syllabus

This work from TeachingForward.net by Jennifer Judkins licensed under a  
Creative Commons AttributionNonCommercial 4.0 International License  51
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Assignments Page - View & Grade Student Work 
Access Assignments page by clicking on assignment name  

   anywhere on Class Page 

 
 

● (A) Assignment Details / Assignment Status Click to switch between the detail 
view of the assignment and the status.  View above shows “Assignment Status”  

● (B) Assignment Folder - Every time you create an assignment, a folder is 
automatically created in Drive.  Once students begin to edit their assigned 
document, you will be able to see their work in progress inside this folder 

● (C) Points - Defaults to 100 (%) but can adjust point value for assignments or 
choose “ungraded” 

● (D) Return - turns ownership of file back to student and notifies them that it’s 
been graded / commented on by teacher 

● (E) Select Students or class to email or return assignments 
● (F) Download CSV of student grades 

 

Additional Resources 
Check out Google’s Classroom Support page for more information!  

● Video:  Introducing Google Classroom - 2 mins 
● Video:  Newest Classroom Features - Allison Mollica - 6 mins 
● Video:  Google Classroom Student & Teacher Views - MA GEG - 40 mins 
● Video:  Classroom Tour - Jenn Scheffer - 15 mins 

 
This work from TeachingForward.net by Jennifer Judkins licensed under a  
Creative Commons AttributionNonCommercial 4.0 International License  
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